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Using the LPDDR Bus Decoder

The Agilent B4623 bus decoder for LPDDR, used with an Agilent
Technologies logic analyzer, lets you decode and view transactions,
commands, and data from a LPDDR1, LPDDR2, or LPDDR3 SDRAM
memory bus in your device under test.

TIP The LPDDR1 memory bus is also know as LPDDR; however, in this help "LPDDR" is used
when referring to either bus and "LPDDR2" and "LPDDR1" are used when referring to
specific memory buses.

The LPDDR memory standard follows the same architecture as the
previous DDR memory buses. Commands and address are unidirectional
signals from the memory controller to the memory parts. They are
synchronous to a differential common clock (CK) which is running at half
the data transfer rate. The data bus (DQ) is bidirectional. It is source
synchronous to bidirectional differential strobes (DQS). The strobes are at
the same frequency as the common clock with the data being sampled on
both edges. The strobes are edge aligned with the read data and centered
in the write data.

The strobes are active only during actual data transfers. The strobes are
delayed from the read and write commands by a fixed number of clock
cycles. This delay or latency needs to be entered into the decoder interface
as Total Read Latency and Total Write Latency.

The LPDDR data bus is displayed as raw hexadecimal data. The decoder
does not inverse assemble the data payload.

The decoder works with these types of memory bus probes:

e Agilent W2637A LPDDR1 x16 BGA probe.

e Agilent W2638A LPDDR1 x32 BGA probe.

* Soft Touch or Soft Touch Pro embedded custom midbus probing.

These topics tell you more about using the LPDDR bus decoder:

e Chapter 1, “Installing Software and Licenses,” starting on page 7

e Chapter 2, “Setting Up for LPDDR Bus Decode,” starting on page 11
e Chapter 4, “Capturing Data,” starting on page 39

e Chapter 5, “Understanding the Listing,” starting on page 41

e Chapter 6, “Filtering or Colorizing the Display,” starting on page 53
e Chapter 7, “Troubleshooting the Decoder,” starting on page 55

Related Tools The decoder includes an Address Conversion Tool that converts row
and column addresses into physical addresses. For more information,

see "To convert to and from physical addresses" on page 40.
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e The DDR Setup Assistant is a wizard-like application that helps you set
up your logic analyzer properly for DDR data capture and analysis. It
guides you through the setup process and automates setting threshold
voltages and sample positions for control/address signals. For more
information, see "DDR Setup Assistant—At a Glance" (in the online
help).

e The DDR3 Eyefinder tool helps you set the logic analyzer sampling
positions for read data and write data signals. For more information,
see "Using DDR3 Eyefinder" (in the online help).
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The Agilent B4623 Bus Decoder for LPDDR software decodes the acquired
LPDDR traces. The acquisition can be done using an Agilent Logic
Analyzer module. You can also use this software to decode the LPDDR
data offline.

This software allows you to view transactions, commands, and data from a
LPDDR, LPDDR2, or LPDDR3 memory bus (depending on which license of
the software is installed).

To use the B4623 Bus Decoder for LPDDR software, you need to install
the following software components from the Agilent web site at:
"www.agilent.com/find/la- sw- download".

a The B4623 software works with the Agilent Logic and Protocol
Analyzer software. Therefore, you must ensure that the Agilent Logic
and Protocol Analyzer software is installed.

b Install the "Agilent B4623 Bus Decoder for LPDDR" package and
follow the instructions on your Entitlement Certificate to enable its
license (see “B4623 Licenses" on page 8).

¢ Install the "Agilent DDR Setup Assistant and Eyefinder" package. The
DDR3 Eyefinder tool is not a licensed software. If you are
performing DDR measurements without the B4623 bus decoder for
LPDDR, you must install the "Agilent DDR3 Eyefinder" package from
the Agilent web site.

See Also ¢ '"Inverse assembly tools" (in the online help)
* "To install a tool" (in the online help)

e For information on how to probe the signals, see Chapter 2, “Setting Up
for LPDDR Bus Decode,” starting on page 11.

Agilent Technologies
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1 Installing Software and Licenses

B4623 Licenses

The following two licensed options of the B4623 software are currently
available.

e B4623A license
e B4623B license

B4623B is an upgrade license and provides the following additional feature
in comparison to B4623A.

e Decoder support for LPDDR3

With the B4623A license, you cannot open and use an LPDDR3
configuration file. Doing so, results in the display of the following error
message.

File Open Errars:

LPDDR3 support requires an upgrade icenze. To purchase an upgrade license, contact pour Agilent Technologies zales reprezentati

LPDDRS3 configuration files require the B4623B upgrade license. Contact
Agilent Technologies sales representative to purchase this upgrade license.
Once you have installed this license, you can access all the available
LPDDR files including LPDDRS3 files.

A similar error message is displayed when you have only the B4623A
license and you try to select LPDDR3 as the DDR bus type in the DDR
Setup Assistant wizard while defining the LPDDR setup.
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DDR Setup Assistant

Steps in DOR. setup:

Setting up: LPDORZ - = Softtouch

E Specify Input Parameters

[A werify Software Installation
[A Load Configuration File

[] Do Hardware Setup

[] set Initial Threshaolds

[] set Sample Pasitions of ClkfiCs
[J set Sample Positions of Comm
[] Find Latency Yalues

[] set Sample Pasitions of Data F
[] save setup

In this step you will load a configuration file that customizes vour logic a

orobina solution and karaet svstem.,

File Load Error

Caonfiguration File load Failed,

Errors:

]|

LPDDRS support requires an upgrade license, To purchase an upgrade

license, contact vour Agilent Technologies sales representative,

To see more details on licenses select the Help-=Software Licensing... menu

ikern.

If wou are trving to open a . ala file, wou can still view and analvze it in offline

mode where no licenses are required,

Help |

endar,

that has b

<-- Previous Step | Step Completed --= |

Upgrading to the B4623B license allows you to select LPDDR3 in the DDR
Setup Assistant wizard.

You can check if the B4623A or B4623B license is installed on your PC by

clicking Help > Software Licensing.... in the Agilent Logic and Protocol

Analyzer GUIL
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Softuare Licensing

Summary | Activation I Floating Licenze Servers I Bu:urn:uw|

Active Software Licenzes

EI -+ _a| Aglent Bus Decoder for DDRZ and DDR3
i oo 2 BABZ1A-010, avalable from local system b

I'1'-|:||||-'r|f LFDDRAPDDRZ Decoder
: =, BABZ34-010, available from local system
EI *" _gJ DDH2 / 3 Protocol Compliance and Analysiz Tool
84522-'3. 010, availlable fru:um ||:u:a| s_l,lstem

e . | :

m

' 1l

[ indicates that the azsocated saftware which uzes this icense iz not installed.]

Show Detailz... [ Copy to Clipboard ]
o) o) [ oo

See Also + "To activate software licenses" (in the online help).
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.

The easiest way to set up the logic analysis system for LPDDR bus decode
is by using the DDR Setup Assistant. The DDR Setup Assistant is a
wizard-like application that helps you set up your logic analyzer properly
for DDR data capture and analysis. It guides you through the setup

process and automates setting threshold voltages and sample positions for
control/address signals. See:

e "Using the DDR Setup Assistant" (in the online help)

The following topics describe how you can set up for LPDDR bus decode
without using the DDR Setup Assistant.

¢ "Connecting to the Device Under Test (DUT)" on page 12
¢ "Configuring the Decoder" on page 13

Agilent Technologies 1



2  Setting Up for LPDDR Bus Decode

Connecting to the Device Under Test (DUT)

The bus decoder is intended for use with Agilent's LPDDR memory bus
probes.

You need to connect the probe to your device under test, then connect the
logic analyzer pods to the probe.

For information on how to make these connections, see the manual for the
probe you are using.
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Setting Up for LPDDR Bus Decode 2

Configuring the Decoder

What to
Configure

Understanding
Sample Positions
and Latency
Settings

Configure the logic analyzer by loading a configuration file then adjusting
the settings for your device under test.

* "To load a configuration file" on page 13
e "To configure the decoder" on page 15

e "To set sampling positions" on page 19

Sample Positions tell the logic analyzer when to sample each signal. If the
sampling positions are not set correctly, data cannot be captured reliably.

Total Read Latency and Total Write Latency settings tell the decoder
how to align the captured data. These values represent the total latency
for your system and therefore should include parameters that affect total
latency. If the latency settings are not correct, data will appear to be
misaligned with the corresponding command in the waveform and listing
displays.

To load a configuration file

Several Agilent provided configuration files are available for use with the
LPDDR decoder depending on the installed software license (B4623A or
B4623B). With the B4623B license, you get an additional LPDDR3 decode
support that allows you to access and use LPDDR3 configuration files as
well.in addition to the LPDDR1/2 files.

When you load a configuration file, it will set up the buses and signals,
add the decoder tool, and add a listing tool.

If you are using the decoder without an Agilent LPDDR probe, see "To
create a configuration file" on page 14.

To load a provided configuration file:
1 Close the logic analyzer window, if it is open.

2 Select Start>All Programs>Agilent Logic Analyzer>DDR Bus Decoder
Default Configs.

3 Select the LPDDR bus type.

4 Select the directory corresponding the model number of probe you are
using and then choose a configuration file corresponding to the bus size
and speed.

When you click on a configuration file, the Logic and Protocol Analyzer
software will start and configure itself to use the decoder.

B4623 LPDDR Bus Decoder User Guide 13
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See Also

To load a provided configuration file without restarting the logic and
protocol analyzer software:

1 Select File>Open....
2 Navigate to the configuration file. The default location is:

On Windows XP

C:\Documents and Settings\All Users\Shared Documents\Agilent Technologies\
Logic Analyzer\Default Configs\Agilent\LPDDR Bus Decoder Default Configs

On Windows 7

C:\Users\Public\Documents\Agilent Technologies\Logic Analyzer\Default
Configs\Agilent\LPDDR Bus Decoder Default Configs

3 Select the file and click Open.
The provided configuration files are read-only. If you modify the

configuration and want to save your work, select File>Save As... and save
the configuration with a new name.

At times, when you try to open a configuration file, the following error message is
displayed. This error message indicates that the file you are trying to open requires the
upgrade license - B4623B and the license currently installed is B4623A. To open such a
file, you need to purchase and install the B4623B upgrade license.

File Open Errors:

LFDDR3 support requirez an upgrade license. To purchasze an upgrade licenze, contact your Agilent

<] |

You can verify which license of B4623 is currently installed by clicking Help > Software
Licensing in the Logic and Protocol Analyzer GUI.

To update a .ala configuration file which was saved using a previous
version of the decoder, see "To load a configuration file from a previous
version of the decoder" on page 15.

To create a configuration file

The provided configuration files are only valid when used with the
corresponding Agilent LPDDR memory probe.

B4623 LPDDR Bus Decoder User Guide



Setting Up for LPDDR Bus Decode 2

If you are using some other probing scheme, you must create your own
configuration files. Extreme care must be taken to ensure that your
configuration files meet the requirements of the decoder.

e Use a provided configuration file as a model.

e Make sure that your configuration file has the same buses and signals
as the provided configuration file. The name and size of each bus and
signal must be exactly the same as it is in the provided configuration
file.

e Verify that the buses and signals listed in "Buses and Signals Captured
by the Logic Analyzer" on page 42 are all present.

To simplify the procedure of customized configuration file creation, Agilent
provides the DDR/LPDDR Custom Configuration Creator tool. The tool
ensures that all the layout information needed by LPDDR Decoder is
included in the created configuration file.

This tool is a part of the Agilent DDR Setup Assistant and Eyefinder
software package. Therefore, the tool is available only after you install this
package.

To know more about this tool, refer to its online help that gets installed
with this tool’s software.

To load a configuration file from a previous version of the decoder

When you upgrade the decoder, the new version of the decoder may have
different input buses and signals. If you load an .ala configuration file
which was saved with the old version of the decoder, you may see error
messages. Follow this procedure to update the configuration file for the
new decoder.

1 Open the .ala configuration file.

2 Write down the user preferences or take a screen shot of the user
preferences.

Save the configuration file (with data) using the .xml format.
Open the Overview display and remove the decoder.

Load the .xml configuration file.

Add the decoder.

Restore the user preferences.

0 N o 61 A W

Save the configuration as using the .ala format.

To configure the decoder

Use the System Configuration dialog to tell the decoder which chip
selects will be used by your device under test and to specify details about
how the bus works.

B4623 LPDDR Bus Decoder User Guide 15
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Toopenthe ¢ From the main menu bar, select Tools>SDDR Bus Decoder>System

System Configuration, or
Conflgu;_at:on * In the Overview display, click the Properties button on the LPDDR Bus
talog Decoder tool then select System Configuration.
LPDDR System Configuration
Chip Selects Mermory Configuration

[V|Chip Select 0 [ckEn = Memory Type |LPDDR3 -

IchipSelsct1 [cken Memory Width (32 -
Chip Select 2 | CKED Row Bits |15 '|
Chip Select 3 | CKED v _
Chip Select 4 | CKED v ot llz 'I
ChipSelect5 |CKED = Total Read Latency 4.0 =
ChipSelect6 CkED = Total Write Latency 2.0 =
Chip Select 7 | cien

e A Burst Type | Sequential v

Chip Select 8 | CkED
Chip Select 9 | CKED Burst Length [2 "l
Chip Select 10 |CkED = [ DM Enable
Chip Salect 11 | CKED v [¥] Decode specific exit powerdown conditions. (Requires
S extra processing time).
Chip Salect 12 | CKED
Chip Select 13 | CKED . Physical Address Construction
Chip Select 14 | ckED . a I B |Rmﬁd:h-m I Column Address I
Chip Select 15 | CkED I Fow Address iB.ﬁ. I Column Address I

1 User supplied .NET assembly

Ci\Program Fies\Agilent Technolo Browse.

Physical Address Summary
3938373635333 32 3130292827262524 23222120191681716 1514131211109 8 765 43 21 0

I | | [ [ [ (n{epumimmil s [ [T [ EAPL TR0 [ofo

ok | [ coxe | [ hHep |

Chip Selects All of the chip selects that are being used in the system must be enabled;
otherwise, the decoder will not function correctly. Likewise, any chip
selects that are not used must not be enabled.

You must tell the decoder about the chip selects because chip selects are
active low and unconnected logic analyzer channels float low. Without the
enables, the decoder could not tell the difference between active and
unconnected chip selects.
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Setting Up for LPDDR Bus Decode 2

The decoder compares the chip selects which are enabled in this dialog
with the CS# bits for each state captured by the logic analyzer. It will
decode only those states where the chosen chip selects are active (low).

There can be 1 to 16 chip selects, depending on the size of the CS# bus.
If the size of the CS# bus indicates that fewer than 16 chip selects are
being used, the unused chip selects are disabled in the dialog.

For each of the enabled chip selects, choose which clock enable signal is
used. A state will only be decoded when both an enabled chip select and
the corresponding clock enable bit are active. The choices are determined
by the number of bits in the CKE bus. If only CKE[O] is present, you do
not need to make a selection.

Memory Type Choose the type of memory you are using.

Memory Width This value is used to compute physical addresses. For memory widths
greater than 8 bits, the column address is padded with the appropriate
number of 0 bits. You can see how this works by examining the Address
Summary at the bottom of the dialog as you select different memory
widths.

Row Bitsand Choose the number of Row Bits from the ROWADDR bus that are valid
Column Bits during the Activate cycle. The number of Row Bits will match the number
of pink bits in the Address Summary at the bottom of the dialog.

Choose the number of Column Bits from the COLADDR bus that are valid
during the Read or Write cycle. The number of Column Bits will match the
number of yellow bits in the Address Summary at the bottom of the
dialog.

If ROWADDR and COLADDR are properly defined to reflect the number of
bits in your device under test, when the LPDDR Decoder tool is added to
the logic analyzer, the Row Bits and Column Bits will automatically be set
to the proper values.

If using LPDDR2, then COLADDR[0O] must also be defined. Assign
COLADDR[O0] to any unused channel, and set the signal threshold so that
COLADDRJ[O0] is always zero.

Total Read Enter the number of full clock cycles between the time that a read or
Latency and Total write command appears on the bus and the time when valid data appears
Write Latency on the data bus. These values represent the total latency for your system
and therefore should include parameters that affect total latency.

These latency settings are affected by several factors, including the
inherent read latency of the memory part, the posted additive latency,
write leveling, and the logic analyzer sample position.

Burst Type Select the order of the bytes after the Read/Write Command (Sequential or
Interleaved). The decoder uses this setting to calculate and display the
appropriate physical address for each memory cycle.

B4623 LPDDR Bus Decoder User Guide 17
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Burst Length
DM Enable

Decode specific

exit powerdown

P

18

conditions

hysical Address
Construction

Address
Summary

See Also

Select the number of bursts after a Read/Write Command.

Enables write data masking. This option is available only when the DM_W
bus exists. If DM Enable is set, the decoder will apply the DM_W bits to
the DATA_W bits before displaying the write data value in the 'DDR Bus
Decode' column.

For example, if:

DM = enabled
Memory Width = 32
DM W 0001

DATA W 0123 4567

then the decoder will display the data as:
mem write Ox 0123 45--
This option is disabled if the DM_W bus does not exist.

Choose whether or not you want the LPDDR Decoder to decode and
display the specific power down events from which the DUT exited.

If you deselect this checkbox, the decoder records power down entries and
exits but does not decode the specific event in case of exits. Instead, it
displays a generic exit label in the Listing window for all such exit events.

For detailed information on how to decode and view self refresh and
power down events, refer to the topic "Decoding Self Refresh and Power
Down Events" on page 31.

Choose whether the physical (linear) addresses should be constructed from
{BA,RA,CA} or {RA,BA,CA}. In most cases, the physical address is
constructed from {BA,RA,CA}.

If your system uses a different convention, you need to create a .NET
assembly to translate between a physical address and the various fields
which make up a bus address. If this is the case, select "User supplied
.NET assembly" and refer to Appendix A, “Customizing Physical Address
Construction,” starting on page 59.

The address summary is a picture that shows how physical addresses will
be constructed, based on user inputs for Memory Width, Row Bits, Column
Bits, and Bank Address Location.

e To find the Row and Column Bits and Burst Length, refer to the
technical data sheet for the DDR memory part you are using or capture
data from a mode register set (MRS) cycle as the device under test
boots up.
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To set sampling positions

Data on the LPDDR bus is valid for a very short time. Sample positions
tell the logic analyzer when each signal is valid. You must adjust the logic
analyzer's sample positions in order to reliably capture data on your bus.
In addition, you must set the Total Read Latency and Total Write Latency
in the decoder so that data in the listing will be properly aligned.

The Agilent logic analyzer requires a single clock for all data acquisition.
All signals are sampled on both edges of the sample clock. You need to
identify correct sample points for three clock groups: Command and
Address, Read Data, and Write Data.

1 Install the memory bus probe and connect it to the logic analyzer.
2 Load the default configuration into the logic analyzer.

3 Configure the memory bus.
4

Power up the target with a stimulus that exercises the range of
available memory.

b Set the sampling positions for the Command and Address signals
(LPDDR2/LPDDR3 (see page 19), LPDDR1 (see page 20)).

6 Set the logic analyzer sampling positions for Read Data and Write Data.
There are two ways to do this:

Set sampling positions with the DDR3 Eyefinder (see page 24) — Use
this procedure to set sample positions using an automated tool.

Set sampling positions manually (see page 24) — Use this procedure
for LPDDR. You can also use this procedure for LPDDR2/LPDDR3 if
you have full control of the bus (so you can to generate separate
read and write traffic) and you want precise control over sample
positions.

7 Set the Total Read Latency and Total Write Latency in the decoder.

To set sampling positions for LPDDR2/LPDDR3 Command and Address

1 Set CKO in the first eye just to the left of O.
2 Set CS# and CKE in the similar eye (just left of 0).

3 Then set CA9_0O_R one eye to the left and set CA9_0O_F in the eye that
is most similar to CS#. Refer to the diagram below.

B4623 LPDDR Bus Decoder User Guide 19
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Thresholds and Sample Positions X
Legend
| Current Sample Position {tSample) A Suggested Sample Position Signal Activity Envelope [ Display 8] [ Advanced. .. ]
== Current Threshold (vThresh) 4 Suggested Threshald 2 Signal Activity 104 Channels Selected For Run
| EBuses|Signals to Run 'F‘ 'F _|4 '|3 '|2 'Il E?E } % ? 4 e Samnple Position 2
T T T T T T T
M. CKO | 1 | | I L r ] | tSample = -0.60 ns
T T T T T T T T T
cow | " | tSample = -0.70 ns avg Exp
T T T T T T T T T
WI3C CA2_0_R | | | tsample = -1.48 ns ava o
T T T T T T T T T
M2C GA9_D_F | | | | tsample = -0.19 s avg Bol
_ Auto Sample Position Setup b [a]4 [ Cancel ] [ Help ]
—

Setting the signals CA9_0_R and CA9_0O_F automatically adjusts all of
the other Command and Address buses/signals. (There is no need to
adjust STAT, ROWADDR, COLADDR, COMMAND, COMMANDO, BA, AB,
AP or any other command or address bus signal.)

To set sampling positions for LPDDR1 Command and Address

The Command and Address group of signals consists of CK, CKE,
COMMAND, ADDR, BA, CS#, ODT and RESET#.

The supplied configuration files set the logic analyzer to sample on the
rising and falling edge of the clock, with no positive or negative delay. You
should fine-tune the sampling position for your measurement setup.

Capture some 1 Configure the decoder (see page 15).

data 2 Go to the Sampling tab.

Analyzer Setup for MPC85xx DDR

Buzes/Signals  Sampling |

Acquisition
’7 ' Timing - Asynchronous 5 ampling

& State - Syrchronous Sampling (500

3 Check that TimingZoom mode is enabled (on some analyzers).

TimingZoom
’7|7 Enable —‘
4 Capture some data. To do this, run the analyzer then stop it manually.

J]>©l|
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Set the sampling
positions

1 Open the Sampling tab of the Analyzer Setup dialog.
2 Select Thresholds and Sample Positions....

3 Select the signals associated with the address group.
4

At the bottom of the dialog, select Run the Auto Sample Position
Setup and click Run.

At this point, the results should approximate the initial sample positions
from the configuration.

Some signals may not be active. CKE[1] is only active in dual and quad
rank configurations. Some of the upper ADDR signals may not be active
depending upon the size of the memory size in the target. ODT[1] will not
be active in all target configurations.

Note that using Eye Scan with Sample Position Setup Only can often
provide a better picture of the active and inactive signals.

Verify the sample 1 Run the logic analyzer to capture some data with the new sample
positions positions.

2 In the Waveform window, find a valid DDR command cycle (for
example, when CAS=0). The RAS, CAS, WE, and ADDR signals should
all be valid on the rising edge of the clock (CK). If necessary, adjust the
sample position for each of these signals so that the data eye is
centered on the rising edge of the clock,

3 Capture some more data to ensure that the command signals are
centered.

See also "Example: Sampling Positions for Command and Address" on
page 22.
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Setthe sampling 1 Set the sampling position for CK so that it is centered 1/4 clock period

position for the after the rising edge of CK. In other words, CK must sample itself
clock midway between the rising and falling edges.
Example:
Sampling

Positions for
Command and

Address
Example: Typical
sample positions Th:é:‘inlﬂs and Sample Positions .
T Current Sample Postion tSnple) A Suggested Sample Postion 11 Signal Actviy Envelope
= STt (et - SOoasted Theestiold B8 Sinal Adivky &0 Channels Selscted for Run
Ll L L Bl e B = e (O Sample Postion Messages |
% W STAT tSample = -1.38 ns avg Expand bus bo see 1
. cko CHF " " F T WF " ] tsewle= 190
ewcrowaopr L= W T " T | tsempe=-tsimav Expend bus to see
® @ coaoor || L il ] tsampe = 16005 avg Expand bus to ses f
# WIC BA [ il Al | tsample = -1.51 rs avg Expand busto-sea |
& WOC COMMAND [ - | tsample =-1.62 s avg
¥ co# | i | tsemple=-1.68ns o signal activiy
¥~ RASE [ 1 W | tssmple = 1741
#_I CASE [ P | tsample =-1.63ns
VI WER l i | tsample =-1.4805
¥ I CKE [ Y | tsample=-1.710s o signal ativty, |
| oot e | Co ) (o ) (e ]
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Example:
Waveform display

Setting Up for LPDDR Bus Decode 2

Scale| 10.4 ns/div

Delay

(8)(m](ae (T )20 (M)

BusiSignal

[ek
D Command

={]cs

est
[l CS[2

&= | ADDR

=] Ba

[Jwoas7-0[0)

& | DATA Wi

Example:
Manually
adjusting sample
positions
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1
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1
1l
I| Frecharge

! Refresh
|

00400

Run the logic analyzer to capture some data with the new sample
positions.

In the Waveform window, find a valid DDR command cycle (for
example, when CAS=0). The RAS, CAS, WE, and ADDR signals should
all be valid on the rising edge of the clock (CK). If necessary, adjust the
sample position for each of these signals so that the data eye is
centered on the rising edge of the clock,

"
impl | 153 nz 155 ns 157 ns 152 ns 161 ns 163 ns
'

Bus/Signal T

Tri....

Ock az)
CMD (TZ)

[Iras (12)

[ cas (z)

(we az)

Rising Edge

Data Eye of CAS
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See

To do this:

a For each signal, note how far it needs to move to be centered under
the rising clock edge.

In the picture above, the center of CAS signal is about 1.3 ns before
the rising edge of the clock. Note that since the other command
signals are held high, you would need to find a different command
cycle to see how the eyes of those signals line up with the clock.

b Open the Sampling tab of the analyzer Setup dialog.
¢ Select Thresholds and Sample Positions....

d Change the sample positions.

1 z 3 4 5 :15 Sample Position

T T Jeaes B[+

3 Capture some more data to ensure that the command signals are
centered.

To set sampling positions using DDR3 Eyefinder

The DDR3 Eyefinder is an extension of Agilent's eye finder and eye scan
technology. It helps select sample positions for the data signals on the
LPDDR2 bus.

The DDR3 Eyefinder application can be used to identify the correct sample
position on the data bus. This tool is designed to work even when the
target is not able to generate selective read-only or write-only activity on
the memory bus. The application is able selectively examine only the
active data portion of read cycles or write cycles on a bus with mixed
traffic.

The Command and Address sample positions must be properly selected before utilizing this
tool.

* "Your First DDR3 Eyefinder Scan" (in the online help)

To set sampling positions manually

If you have the ability to produce read-only and write-only data on the
bus of your device under test (using ITP control or equivalent), you can
generate patterns on the bus and set the sampling positions manually.

Data is valid on rising/falling edge of the associated data strobe signals,
but the logic analyzer does not have the ability to latch data using the
separate data strobes. Instead, the analyzer latches data based on the
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Setting sample
positions for Read
Data

Setting Up for LPDDR Bus Decode 2

command clock (CK). The data strobes and CK are not necessarily in
phase, thus the sample position for individual data signals must be
adjusted relative to CK.

Keep in mind that read eyes and write eyes occur on the same signals, but
at different times. A mix of read-data and write-data data will confuse
eye finder because it will not be able to converge on a single eye. To use
eye finder to refine the data sample positions, bus activity on the data bus
must be limited to just reads or just writes.

Once the Command and Address sample positions have been set, The next
task is to identify the correct sample positions for the Read Data. The
read data is synchronous to the DQS strobes. In a stable system there is a
fixed phase offset between the common clock and the strobes. In addition,
there is a fixed clock delay between the read commands and the start of
each data transfer. The clock delay is entered into the decoder setup. The
phase offset requires use of the Threshold and Sample Position tool using
the Auto Eye Scan with Sample Position Setup Only application.

1 Set up your device under test to generate known, continuous read-only
data patterns on the memory bus. A pattern that works well is
alternating OXFFFFFFFF and 0x00000000.

2 On the logic analyzer Threshold and Sample Positions menu deselect the
Command and Address Group signals and select DATA_R, CB_R and
DQS_R.

3 Run the Auto Eye Scan with Sample Position Setup Only application.
The data bus is not actively driven between data transfers.

In many systems the signals float around the threshold. This signal level
uncertainty between data transfers prevents the Threshold and Sample
Positions tool from automatically selecting the correct sample position.
The picture below provides an example of the results of an Eye Scan
with Sample Position Setup Only and how to interpret the results to
obtain the correct sample position.
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Thresholds and Sample Positions
Legend
| Current Sample Position {tSample) A Suggested Sample Position Signal Activity Envelof| Display ¥ @
== Current Threshald (vThresh;) 4 Suggested Threshold = Signal Activity &2 Channels Selected For |
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i E cu——
L |HSTL
Threshold: HSTL
=7 DATA_R [ wThresh = 0,75V
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T T T
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Threshold: HSTL
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4 Once the read data sample positions are selected, find the correct
sample for the DQS_R signal. Utilize the waveform view of the state

acquisition.
Bus/Signal
[ex
=] cKE
E-{ | COMMAND
&= | ADDR
&= | Ba

[Jcs#n

[Joas_r

-4887ns -4608ns  -43.189ns -40.3 nz 3T4Hne -3452ns 31630 -2ET4)
PR T e T T T T T L I

O 00 {o oo (o {ofr oo oo otoo

Write

1

T (01 (o1 o1 (o

Setting Sample The final group is the Write Data.

Positions for 1
Write Data

alternating OxFFFFFFFF and 0x00000000.

2 In the Threshold and Sample Positions tool deselect the read data
group and select the DATA_W, DM_W, CB_W and DQS_W labels.

3 Run the sample position application as with the read data bus and set
the sample position for each bit.

Some system do not utilize the Check Bit (ECC) signals or all of the

Data Mask (DM) signals.

2

Set up your device under test to generate known, continuous write- only
data patterns on the memory bus. A pattern that works well is

The picture below shows an example of the sample positions for Write

Data:
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Thresholds and Sample Positions

Legend
| Current Sample Position {tSample)

== Current Threshold (vThresh)

A Suggested Sample Position
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Scale| 10.4 ns/div Delay

4 M1
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4 To check that all of the Write Data bits are aligned, configure the target
to generate write-only traffic with an alternating 0/1 bit pattern. If
necessary, select a different eye opening so that each DQ signal is
sampled at the same time. In the following example, the first data bit
needs to be adjusted:

Strobe

Data (sample position nesds
to be adjusted)

Data
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2  Setting Up for LPDDR Bus Decode

You do not need to rerun Eye Scan, but you run the logic analyzer after
each adjustment to verify the results.

5 When you are done, check the Listing display to verify that the bit
patterns have been captured correctly.

Tips for setting Remember that the waveform display on the logic analysis system is a
sample positions state waveform (timing is aligned to each sample), not the timing
waveform you would see if the logic analyzer was running in Timing mode.

The threshold settings for signals can have a significant effect on the
ability of the logic analyzer to accurately sample the signals. Targets with
asymmetric signal swings or using a voltage different from the 1.5 Volt
standard may need additional modification to the standard logic analyzer
configuration. If you are unable to find sample positions that support
accurate sampling of the signals on the LPDDR2 bus, use the Auto
Threshold and Sample Position Setup application in the Threshold and
Sample Positions tool.

Because of the float time on the data bus between transfers, do not
depend upon the thresholds or positions selected by this tool. Manually
view each eye diagram and modify the threshold and position to best
select the center of the active portion of each eye.

Generating Data In order to run Auto Sample Position Setup and Auto Threshold on the
for Auto Sample Data signals it is important that the device under test is programmed to
Position and Auto  generate exclusively Write or Read traffic of a known pattern, such as F's
Threshold and 0's. This is the only way to get usable data windows to set the

sampling positions of both the Read and Write Data labels on the logic
analyzer. At these speeds even one half a data strobe bit width of timing
relationship shift between the strobe (clock) and the data bits will
eliminate the window.

Settingthe The Threshold setting for clocks and signals can have a significant effect

Threshold on the size of the eyes. At speeds of 800 MT/s or higher even a 50 mV
change in the threshold can make all the difference in the eye size as
measured at the logic analyzer. The best way to determine this level is
through trial and error, or through use of the Auto Threshold function.
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°. Down Events

The LPDDR Decoder supports decoding and displaying the entry to and
exit from Self Refresh and Power Down events. Once data is captured and
decoded, you can view the entry and exit from the following events in the
Listing window of the Logic and Protocol Analyzer GUI.

¢ Power down
¢ Deep power down
¢ Self refresh

To ensure that entry and exit from these events are decoded and displayed

in the Listing view, you need to complete the following steps before
capturing data.

e Disable clock qualifiers

¢ Set the clock threshold

Agilent Technologies .
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Decoding Self Refresh and Power Down Events

Disabling Clock Qualifiers

32

The LPDDR Decoder will not be able to decode and display power down
and self refresh events if the clock qualifiers are enabled.

1

Access the Sampling tab of the Analyzer Setup dialog box by clicking the
% toolbar button in the Logic and Protocol Analyzer GUI. Ensure that
you have loaded the LPDDR configuration file/setup in the Logic and

Protocol Analyzer GUI before this step.

In the State Options group box, select Don’t Care for all the clock qualifiers
to disable these qualifiers.

Clock Mode: | Dual Sample -

Pod A2  Pod A1

Activity: I _
Master: X s X ¥ X sz X || H z|ckit
I

Clock qualifiers disabled

3 Click OK.
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Decoding Self Refresh and Power Down Events 3

Setting the Clock Threshold

The clock threshold should be offset by a negative amount in the range of
-60 to -70 mV.

1 Access the Buses/Signals tab of the Analyzer Setup dialog box by clicking
the toolbar button in the Logic and Protocol Analyzer GUI. Ensure
that you have loaded the LPDDR configuration file/setup in the Logic
and Protocol Analyzer GUI before this step.

2 Click the Clock Thresholds button displayed under the clock label.

Buses/Signal: | Sampling

Enter buzes and zignals and the channels they corespond to;

Clocks Slot A Pod 8
Widt

Channels
As=igned

Clock Thresholds Threshold: TTL

Bu=/Signal Hame

3 In the Threshold Settings for Clock Channels dialog box, set the offset of the
clock within the range -60 to -70 mV.

Slot & Pod 1M Clock

Differential  ¥| 0OV 8 - [+ [J

- Offset -6mv (B[] [+ L = -6BmV

Clock threshold offset by -66 mV

4 Click Done.

B4623 LPDDR Bus Decoder User Guide 33



3  Decoding Self Refresh and Power Down Events

Viewing Power Down Events

Once the above-mentioned steps are performed, the self refresh and power
down events are decoded and displayed. The following screen displays an
example of an entry to and exit from the self refresh event in the Listing
window.

led
led
led
led
led
mb led
led
led
led

led

3 B4623 LPDDR Bus Decoder User Guide



Decoding Self Refresh and Power Down Events 3

Enabling/Disabling Decode and Display of Specific Power Down Exit
Events

By default, the LPDDR Decoder decodes and records the specific power
down event from which the DUT exited. This, however, requires extra
processing time for ascertaining the specific exit event on the basis of the
last entry event. If you want to reduce this processing time and do not
want to view the specific power down event from which the DUT exited,
then you can disable this feature.

When you disable this feature, the decoder records these power down
entries and exits but does not decode the specific event in case of exits.
Instead, it displays a generic exit label in the Listing for all such exit
events.

The following screen displays a Listing of such events when this specific
exit event decoding feature is disabled. Notice that the exit is labeled as a
generic exit from self refresh or power down conditions instead of a
specific event from which the exit was made.

I =
Idle
Idle
Tdle
Idle

Clock

-

¥y O
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Decoding Self Refresh and Power Down Events

To enable/disable the display of specific exit events

1 In the Overview display, click the Properties button on the LPDDR Bus
Decoder tool then select System Configuration.

Frohas

o LFooRs

Frobe Connect.. ey

o=

tadules Tools
ol core /L PooR Bus
LFODOR Module § pa/  Decoderd }
¥ f.—é‘lrgi M, [ ][Fropertun =] /
B8l /

Windows

]

W Liztrg1 ‘

The LPDDR System Configuration dialog box is displayed.

LPDDR System Configuration

Chip Selects

[V|chip Select 0 |ckpn  »

Chip Select 2 | CKED l
Chip Select 3 | CKED v
Chip Select 4 | CKED

Chip Select 5 | CKED v
Chip Select & | CKED -
Chip Select 7 | CKED -
Chip Select 8 | cKED -
Chip Select 9 -:KEEI v
Chip Salect 10 -’rEj -
Chip Salect 11 | CKEQ o
Chip Select 12 |ckED  ~
Chip Select 13 -L'I\'Ei'.l .
Chip Select 14 | CxED -
Chip Select 15 | CKEQ

Physical Address Summary

[lchipSelect 1 |ckEn ¥ |

Memory Configuration
Memory Type  |LPDDR3 v)
Memory Width |32 v
Row Bits 15 v
Coburnn Bits [12 v]
Total Read Latency 4.0
Total Wrike Latency 2.0 -
Burst Type | sequential -
ezl 2 5
[ DM Enable
[+ mrm a;tm p;mrdwn conditions. (Requires
Physical Address Construction

@ [ B4 | RowAddress | Column Address |

O | Row address | Ba | Column Address |

) User supplied .NET assembly
Ci\Program Fies)Agilent Technolo Browse..

I9FBITI6F0343332 31302928 27262524 2322212019181716 1514131

211109 8 76543210

i | [ [ (pminin] (SUSuimieimel s [ (] [OQ1T 1000 o

[

OK

I

| Cancel

| |

Help

)
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2 By default, the feature to decode specific exit power down events is
enabled. To disable it, deselect the Decode specific power down conditions
checkbox.

3 Click OK.
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Lo, Capturing Data
o

To capture any data, the logic analyzer must run a measurement then end
the measurement (either manually or by detecting a trigger).

Normally, the trigger will be an address detected on the bus.

1 Set the logic analyzer to trigger when the address is encountered. You

may need to convert (see page 40) a physical address to the row and
column addresses which will appear on the bus.

2 "Run" (in the online help) the logic analyzer.

3 Run the device under test.

The logic analyzer will trigger when address is found on the bus.
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4 capturing Data

To convert to and from physical addresses

To open the
Address
Conversion Tool
dialog

To converta
row/column
address to a
physical address

To converta
physical address
to a row/column

address

Address
Summary

40

Use the Address Conversion Tool dialog to convert a physical (linear)
address into an equivalent bank address. You can also use the tool to
convert a bank/row/column address into a physical address. Before you
use this tool, you must configure the decoder (see page 15).

The dialog contains three representations of the address:
* Bus Address

e Physical Address (hexadecimal)

e Physical Address (graphical summary showing each bit)

You can edit any of these representations. As you make changes, the other
representations are calculated and displayed immediately.

e From the main menu bar, select Tools>DDR Bus Decoder>Address
Conversion Tool, or

¢ In the Overview display, click the button on the DDR Bus Decoder tool
and select Address Conversion Tool.

Enter the row address, column address, and bank address. These values
will be constrained by the memory bus options you set in the System
Configuration dialog. The physical address will be updated continuously to
reflect the values you enter.

Enter the physical address. The other values will be updated continuously
as you enter the address.

The address summary is a picture that shows how the physical address is
constructed, based on user inputs for Memory Width, Row Bits, Column
Bits, and Bank Address.
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.‘0‘. Understanding the Listing
o

The DDR data bus is displayed as raw hexadecimal data. The decoder does
not inverse assemble the data payload.

For an explanation of the columns in the listing, see:
e "Buses and Signals Captured by the Logic Analyzer" on page 42
¢ "Buses Generated by the Decoder" on page 48
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Buses and Signals Captured by the Logic Analyzer

Required input The following buses must be present in the input data to connect with the
buses Agilent LPDDR/LPDDR2/LPDDR3 Decoder, DDR2/3 EyeFinder and DDR2/3
External Applications. They are automatically provided by the default
configuration files. If you create your own configuration file (see page 14),
be sure to define all of the required buses.

Bus Name

Description

ADDR

Address signals. 14 bits wide. (LPDDR1 only)

ROWADDR

Address signals used during an activate command. Typically these are called
the Row Address signals. ROWADDR is typically used by the LPDDR decoder
and by the DDR Trigger application. It is also used by a variety of tools to read
the size of the ROWADDR to determine the number of Row bits valid during
an active.

COLADDR

Address signals used during a read/write command. Typically these are
called the Column Address signals. COLADDR is typically used by the LPDDR
decoder and by the DDR Trigger application. It is also used by a variety of tools
to read the size of the COLADDR to determine the number of Column bits valid
during a read or write.

CKO

Clock signal used by LPDDR/LPDDR2/LPDDR3. This is the signal that was
used to clock the analyzer. This signal must be a single bit.

CKE

Clock enable bits. 1 or more bits wide (depending on how many clock enable
signals are used by your memory system). The decoder will decode a logic
analyzer state only if the appropriate CKE bit is 1.

CS#

Chip select bits, 1 or more bits wide (depending on how many chip select
signals are used by your memory system). The decoder will decode a logic
analyzer state only if the appropriate CS# bit is 0.

BA

Bank address bits, 1 to 4 bits wide (depending on how many bank address
signals are used by your memory system).

RAS#

RAS bit, 1 bit row address. (LPDDR1 only)
RAS# bit is also defined in the STAT bus. Both RAS# and STAT need to be
properly defined.

CAS#

CAS bit, 1 bit column address. (LPDDR1 only)
CAS# bit is also defined in the STAT bus. Both CAS# and STAT need to be
properly defined.

WE#

WE bit, 1 bit write enable. (LPDDR1 only)
WE# bit is also defined in the STAT bus. Both WE# and STAT need to be
properly defined.

42
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Bus Name Description

COMMAND For LPDDR1, COMMAND is a 3 bit wide bus used by a variety of the tools to
simplify control operations. COMMAND contains the 3 bits RAS#, CAS#,
WE# in the following order:
* COMMANDI2] = RAS#
* COMMANDI[1] = CAS#
* COMMANDI0] = WE#
For LPDDR2and LPDDR3, COMMAND is a 4-bit wide bus that encodes all of
the LPDDR2 commands.
For details on the symbolic names used for the COMMAND bus, see:
* "LPDDR2 Command Symbols" on page 45
* "LPDDR1 Command Symbols" on page 45
* "To find commands of a certain type in the listing" on page 46

DATA R, Read and write data payloads. 8, 16, or 32 hits wide.

DATA_W

STAT LPDDR command and control signals.
For LPDDRT, the STAT bus is 18 bits wide.
For LPDDR2 and LPDDR3, the STAT bus is 21 bits wide.
The decoder obtains all command and control information from the STAT
bus plus the CKE and CS# signals. For convenience, some configuration files
also display the signals with their own names.

STAT Bus for
LPDDR1 STAT bus Signal name

STAT [0] RAS#

STAT [1] CAS#

STAT [2] WE#

STAT [3] ADDR[0]

STAT [4] ADDR[1]

STAT [5] ADDRJ2]

STAT [6] ADDRJ[3]

STAT [7] ADDR[4]

STAT [8] ADDR[5]

STAT [9] ADDR6]

STAT [10] ADDR[7]

STAT [11] ADDRJ[8]

STAT [12] ADDRJ[9]

STAT [13] ADDRJ[10]

STAT [14] ADDRJ[11]

B4623 LPDDR Bus Decoder User Guide
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STAT bus Signal name
STAT [15] ADDR[12]
STAT [16] ADDR[13]
STAT [17] CKO
STAT Bus for

LPDDR2 | STAT bus Signal name
STAT [0] CA9_0_RI[0]
STAT [1] CA9_0_RI[1]
STAT [2] CA9_0_R[2]
STAT [3] CA9_0_RI[3]
STAT [4] CA9_0_RI[4]
STAT [5] CA9_0_R[5]
STAT [6] CA9_0_RI[6]
STAT [7] CA9_0_RI[7]
STAT [8] CA9_0_RI[8]
STAT [9] CA9_0_RI[9]
STAT [10] CA9_0_F[0]
STAT [11] CA9_0_F[1]
STAT [12] CA9_0_F[2]
STAT [13] CA9_0_F[3]
STAT [14] CA9_0_F[4]
STAT [15] CA9_0_F[5]
STAT [16] CA9_0_F[6]
STAT [17] CA9_0_F[7]
STAT [18] CA9_0_F[8]
STAT [19] CA9_0_F[9]
STAT [20] CKO

Optional input There may be additional buses in Agilent- supplied configuration files.
buses and signals These are not required by the decoder but are helpful to the user.
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5

Bus Name

Description

DM_W

Data Mask. If this bus exists and Data Mask Enable is enabled in the System
Configuration dialog, the decoder will apply the DM_W to DATA_W data
before displaying the data in the 'DDR Bus Decode' column. The number of
bits in the bus must match the number of bytes in the DATA_W bus. The least
significant bit of DM_W, if set, will mask the least significant byte of
DATA_W.

The bit ordering for the DM signals follows the convention used by JEDEC,
where bit 0 is the least-significant bit.

Other input buses These signal names are entirely optional. They are used by the DDR3
and signals EyeFinder if they exist. The DDR3 EyeFinder will locate the eyes on the
following signals:

Bus Name Description

DQS_R Data Strobes for Read

DAS_ W Data Strobes for Write
LPDDR2 Command Symbols

Command bus symbols for LPDDR2:

I CAI_O_R
I CAI_O_F
[=E'a C O MMARD

(=] ROWADDR

8 MNOP 111X Binary

5 Write 100X Binary
5 Activate 013 Binary

5
5
5
8 BST 1100 Binary
5
5
5

»
§ Read 101X Binary

FPrecharge 1101 Binary
Refresh 0011  Binary
Refresh bank 0010 Binary
Mode Register'Write 0000 Binary
Mode Register Read 0001 Binary
Readtyrite 10:%  Binary

v

LPDDR1 Command Symbols

The Command bus for LPDDR1 consists of the signals RAS#, CAS#, and

WE#.

With the Command bus, the following symbols are defined:

B4623 LPDDR Bus Decoder User Guide
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Command bit
Symbol Description [2]RASH#H [1]CAS# [0] WE#
NOP 1 1 1
Activate 0 1 1
Read 1 0 1
Write 1 0 0
Read/Write 1 0 X
Burst Terminate 1 1 0
Precharge 0 1 0
Self Refresh 0 0 1
Mode Register Supersedes user |0 0 0
Set preferences. See
"To configure the
decoder” on
page 15.
To find commands of a certain type in the listing
1 Open the Find dialog.
2 For the bus/signal name, choose Command.
3 Check that the numeric base is set to Symbol.
4 Select the command you wish to find.
Find X
Find occurrence searching |Forward |+ | from | Display Center ]
. Fi e e
[store Favorite ¥] [RecalFavorite %) [ clear | [ options... | [ _Fnd ][ close ][ Heb

For LPDDR2/LPDDR3, use "CS# = Low" and "CKO = High" in the search.
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Find X
Find 1 E] occurrence searching |F0rward .V;| from |Display Center V|
(¥]|Busisignal | [_commanp | ¥ | [albits |v]||= || [write J(Eem_¥] [and v

E] Bus{Signal + cs# ¥ | Low .V; |,qnd .V;|
E] Bus/Signal [ KD ¥ ] High Iv;

When |Present Iv;

[Store Favorite 8] [Recall Favorite 8] [ Clear ] [ Options... ] [ Find ] [ Close ] [ Help
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Buses Generated by the Decoder

Physical Address

DDR Bus Decode

Decoded
commands

48

The decoder generates the following columns, which are displayed in the
listing in addition to the input buses.

When valid read or write data is present on a DDR cycle, the decoder will
display the full physical address in this column. This address is
constructed from the row, column, and bank address, based on the
memory characteristics which were entered in the System Configuration
(see page 15) dialog.

The initial physical address of a burst is shown in two places: on the main
row of the Read or Write command and on the row of the first read or
write. Repeating the value next to the command allows the value to
appear in the Waveform display.

Sample Number PhysicalAddress Cycle Type

a command cycle Idle
A-0 Command

-

This column contains decoded data from the memory bus. Some of the
things which can be displayed in this column include:

Decoded commands may cover several rows (a main row and several
subrows which appear as part of one state).

In the example below, note that the subrows for the write

(17466.1- 17466.11) show data from the data cycles that are associated with
the write (samples 17476 and following). Note also that these samples are
marked as "Data Write" in the Cycle Type column.
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Sample Mumber FPhysical Address DDR Bus Decode

Decode Errors An error message is displayed when the decoder can not decode the state.
Examples include:

e "Please enable one or more chip selects"
e "More than one active chip select"

e "Required Buses/Signals are not present"

"Deselect” The message "Deselect" is not an error. It simply indicates states where
there is nothing to decode and the chip selects are not being used (that is,
they are deselected). Idle states are a common example of this.

This message appears only on the rising edge of the clock. The falling edge
is left blank, because no valid command is possible on those states.

Cycle Type The decoder generates a cycle type column which shows summary
information about each state. See "Cycle Type" on page 50 for an
explanation.

Other buses The following buses and signals are generated by the decoder for its own
use. They are generally not displayed as columns in the listing, but they
are visible in some dialogs.

* TAG

SeeAlso ¢ "Buses and Signals Captured by the Logic Analyzer" on page 42
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Cycle Type

Cycle Type
columns

Predefined cycle

50

type symbols

The decoder generates data which identifies the type of memory operation
for each state in the listing. This generated data appears in the listing as

the Cycle Type column.

Cycle Type does not appear in the Bus/Signal Setup dialog because it
contains information generated by the decoder, rather than information
captured by the logic analyzer.

Each cycle type value is a 32-bit integer. To avoid any need to interpret
these values yourself, the configuration file defines symbols for each cycle
type, such as idle, data read, or command.

The symbols are:

Bits Meaning

0-3 Command code

4 Command
5 Read

6 Data

7 Subrow
)

8

9

Clock disabled

Decode Error

Decode Error
Clock Disabled

Command & Data

Data
Read data
Write data

Idle

Command
Mode Set Command
Refresh Command
Precharge Command
Activate Command
Write Command
Read Command
BST Truncate
NOP

* R/W Data

R

=

1l Il
I Il
vV V. V V

Il
]
\VARY)

command,

read,
data,

subrow

clock disabled
decode error

Binary
Encoding

(LS bits)

XXXX
XXXX

XXXX

XXXX
XXXX
XXXX

XXXX

XXXX
XXXX
XXXX
XXXX
XXXX
XXXX
XXXX
KXXXX
XXXX

XXXX
XXXX

xx1x
xx01

xx00

xx00
xx00
xx00

xx00

xx00
xx00
xx00
xx00
xx00
xx00
xx00
xx00
xx00

xx00
xx00

XXXX
XXXX

01x1

01xx
01llx
010x

00x0

Oxx1
Oxx1
Oxx1
Oxx1
Oxx1
Oxx1
Oxx1
Oxx1
Oxx1

1xxx
11xx

XXXX
XXXX

XXXX

XXXX
XXXX
XXXX

XXXX

XXXX
0000
0001
0010
0011
0100
0101
0110
0110

XXXX
XXXX

o O O o
I
Il
vV V. V V

o
Il
Il

Hex
Value

50

40
60
40

00

10
10
11
12
13
14
15
16
17

80
co

Aut

not
not
not
not

o,

comm
read
data
subr

2 ==> Prechar
and

(i.e. write)
ow (ie. mainr

clock enabled
not decode error

Don't
Mask

FFFF
FFFF

FFFF

FFFF
FFFF
FFFF

FFFF

FFFF
FFFF
FFFF
FFFF
FFFF
FFFF
FFFF
FFFF
FFFF

FFFF
FFFF

FC3F
FC1F
FC1F

FC2F

FCe6F
FC60
FC60
FC60
FC60
FC60
FC60
FC60
FC60

FC7F
FC3F
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The order of the
symbols is
important

Using Cycle Type
to filter the
display

Using Cycle Type
to find data of a
certain type

Understanding the Listing

* R/W Read Data xxxx xx00 111x xxXXX EO FFFF FC1F
* R/W Write Data XXXX xxX00 110X XXXX Co FFFF FCL1F

Here are definitions of some of the more general cycle types:

Cycle Type Meaning

Read Data Clock is rising or falling and the data bus
contains valid read data.

Write Data Clock is rising or falling and the data bus
contains valid write data.

Command Clock is rising and a valid command (possibly
Nop) is on the bus.

Idle Clock is rising or falling and the data bus does

not contain valid read/write data.

Subrows (also called subcycles) are generated
by the decoder to show the data associated
with a command. Each subrow is assigned a
decimal sample number (such as "1234.5").

Decode Error

The decoder encountered an error while
decoding the bus. The DDR Bus Decode
column contains information about the cause
of the error.

The first cycle type in this list which matches the value on the Cycle Type
bus is the one which will be displayed.

You can set up a filter to hide states where Cycle Type is "Idle" or some
other value you do not wish to see in the listing. To change the filter
settings, see Chapter 6, “Filtering or Colorizing the Display,” starting on

page 53.
1 Open the Find dialog.

Wiews Setup Tools

[

2 Choose Cycle Type bus.
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Understanding the Listing

Find

3

Find 1 E] occurrence searching |F0rward v|ﬁom |Display Center Iv;|

|| [[rite Bata ) (Sym_¥)

E”Busf‘signal vH CydeType[ ¥ |=
When |Present ,V;

[Store Favorite 8] [Recall Favorite 8] [ Clear

] [ Options... ] [ Find

] [ Close ] [ Help

3 Set the numeric base to Symbol.
4 Select the cycle type you wish to find.

B4623 LPDDR Bus Decoder User Guide



e 0 @O .
.'0‘. Filtering or Colorizing the Display
O

See Also

B4623 LPDDR Bus Decoder

User Guide
[ ]

The filter tool lets you show or suppress states, based on criteria such as
the cycle type or chip select. You can also display each type of state in a
different color.

The filter settings do not affect whether data is stored by the logic
analyzer; they only affect whether that data is displayed or not. You can
examine the same data with different settings, for different analysis
requirements.

Filtering allows faster analysis in two ways. First, you can filter unneeded
information out of the display. For example, suppressing idle states will
show only states in which a transaction was completed.

Second, you can isolate particular operations by suppressing all other
operations. For example, you can show just write commands, without the
associated data.

To prevent certain data from being stored, use the logic analyzer's "storage
qualification" (in the online help) feature.

e "The filter/colorize tool" (in the online help)
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Error messages

Decode Error

"Slow or Missing
Clock" error

"Add In does not
unattach from all
labels!" error

B4623 LPDDR Bus Decoder
User Guide

@oe: ]/

.‘0'. Troubleshooting the Decoder
o

If you encounter difficulties while making measurements, use this help
topic to guide you through some possible solutions. Each heading lists a
problem you may encounter, along with some possible solutions.

When you obtain incorrect decoded results, it may be unclear whether the
problem is in the connections, in your device under test, or in the decoder
settings. If you follow the suggestions in this section to ensure that you
are using the decoder correctly, you can proceed with confidence in
debugging your device under test.

If you still have difficulty using the analyzer after trying these suggestions,
please contact your Agilent Technologies representative.

When you are working with the analyzer, be sure to power down both the analyzer
and the device under test before disconnecting or connecting cables or probes.
Otherwise, you may damage circuitry in the analyzer or device under test.

In the Cycle Type column, this indicates that decoding failed for some
reason. See the DDR Bus Decode column for a description of the error.

e Check that you have loaded the correct configuration file for the probe
you are using. Signals are mapped differently, depending on which
configuration file is loaded.

* This error message might occur if the logic analyzer cards are not
firmly seated in the logic analysis system frame. Ensure that the cards
are firmly seated.

e This error might occur if the device under test is not running properly.
Ensure that the device under test is on and operating properly.

e If the error message persists, check that the logic analyzer pods are
connected to the proper connectors.

This message can occur when you have loaded an .ala configuration file
which was saved using a previous version of the decoder. To update the
file to work with a new version of the decoder, see "To load a
configuration file from a previous version of the decoder" on page 15 .

Agilent Technologies -



7  Troubleshooting the Decoder

Slow
performance

Intermittent data
errors

No activity on
activity indicators

No trace list
display

56

If, just after capturing a trace, the logic analysis system "hangs up" and
the following status message is displayed at the bottom of the screen, the
decoder is busy decoding the captured data.

Skakus, .. ||Pr0cessing [Listing-1] ... v |

If the "Processing" message doesn't go away after a minute or two, it is
possible that the decoder is searching through an enormous number of
idle states in between "meaningful" states.

e Use the Cancel button to stop the decoder.

Listing ‘Window Help
@ |~
12 [ 2 = [

This problem is usually caused by poor connections, incorrect signal levels,
or marginal timing.

e Remove and re-seat all cables and probes, ensuring that there are no
bent pins or poor probe connections.

¢ Adjust the threshold level of the data pod to match the logic levels in
the system under test.

e Use an oscilloscope to check the signal integrity of the data lines.

¢ Clock signals for the state analyzer must meet particular pulse shape
and timing requirements. Data inputs for the analyzer must meet pulse
shape and setup and hold time requirements.

* Check the sampling positions (see page 19).

See also Capacitive loading (see page 57) for information on other sources
of intermittent data errors.

¢ Check for loose cables.

e Check for bent or damaged pins.

If there is no trace list display, it may be that your trigger specification is
not correct for the data you want to capture, or that the trace memory is
only partially filled.

* Check your trigger sequence to ensure that it will capture the events of
interest.

e Try stopping the analyzer; if the trace list is partially filled, this should
display the contents of trace memory.
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Analyzer won't If logic analyzer power is cycled when the logic analyzer is connected to a
powerup device under test that remains powered up, the logic analyzer may not be
able to power up. Some logic analyzers are inhibited from powering up
when they are connected to a device under test that is already powered
up.

e Remove power from the device under test, then disconnect all logic
analyzer cabling. This will allow the logic analyzer to power up.
Reconnect logic analyzer cabling after power up.

Erratictrace ¢ Do a full reset of the device under test before beginning the
measurements measurement.

* Ensure that your device under test meets the timing requirements of
the applicable JEDEC bus standard.

e See Capacitive loading (see page 57). If the device under test design
has extremely close timing margins, loading from probes may cause
incorrect functioning and give erratic trace results.

¢ Ensure that you have sufficient cooling for the device under test while
the probes are installed.

Capacitive Excessive capacitive loading can degrade signals, resulting in incorrect
loading capture, or system lockup in the microprocessor. All probes add additional
capacitive loading, as can custom probe fixtures you design for your
application.

Careful layout of your device under test can minimize loading problems
and result in better margins for your design. This is especially important
for systems that are running at frequencies greater than 50 MHz.

Remove as many pin protectors, extenders, and adapters as possible.

No decoding or This problem may be due to incorrect synchronization, modified
incorrect configuration, incorrect connections, or a hardware problem in the device
decoding under test. A locked status line can cause incorrect or incomplete
decoding.

* Ensure that each logic analyzer pod is connected to the correct
connector.

There is not always a one-to-one correspondence between analyzer pod
numbers and connector numbers. Probes must supply address, data,
and status information to the analyzer in a predefined order.

* Check the activity indicators for status lines locked in a high or low
state.

e Check that the signals on the device under test are routed to the
connector according to the manual for your probe.
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Decoder will not
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Troubleshooting the Decoder

load or run

Verify that the required input buses have not been modified from their
default values. These buses must remain as they are configured by the
configuration file. Do not change the names of these labels or the bit
assignments within the labels. Some analysis probes also require other
data labels.

Verify that storage qualification has not excluded storage of all the
needed states.

Verify that you have correctly configured the sampling positions.

Ensure that you have the correct software loaded on your analyzer.

Configuration files for the state analyzer contain a pointer to the name
of the corresponding inverse assembler or decoder. If you delete the
decoder or rename it, the configuration process will fail to load the
decoder.
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Physical Address
Construction
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To create a
custom algorithm

B4623 LPDDR Bus Decoder

User Guide
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@oc: A

°. Construction

.' ® ‘. Customizing Physical Address
O

DDR memory systems use rank, bank address, row address and column
address to construct a physical memory address. The algorithm for
converting BA, RA and CA to physical address is implementation
dependent. If your system constructs addresses using an order other than
{BA,RA,CA}, you neet to provide an algorithm to translate the bits which
the logic analyzer captures into the BA, RA, and CA values. This algorithm
is in the form of a .NET assembly .dll.

1 Create a Microsoft Visual Studio 2008 .NET assembly:

Use the class "DDRtoPhysical", which implements the methods
described below.

The assembly name and the namespace are user defined but must be
identical.

8 VBClassLibrary - Microsoft Visual Studio

File Edit Miew WVaAssist® Project  Build Debug Data  Tools  Test  Apalyze  Window  Help

YRR~ W= N P Release * Any CPU - | [# The MET assembly
Solution Explorer - Solution 'WBClassLib.., - I X Classl.vh ¥BClassLibrary ~start Page
2| & [E]] &5

J Solution "WBClassLibrary' {1 project) Application

= Efﬂ ¥BClassLibrary |

i=d| My Project Compile
18] Classt.vb

Source Control Explorer Object Browser

Assembly name:

|WBClassLibrary

Debug (

References

Application bype:

Resources | Class Library v|

Services Startup DbJECt ............................................. !

2 Select the "User supplied .NET assembly" button in the System
Configuration dialog and specify the location of the .dll file you created.
The default location is

C:\Program Files\Agilent Technologies\Logic Analyzer\
DDRtoPhysical.dll

If the user has selected "User supplied .NET assembly" and the specified
.dll does not exist; the user will get the following error message when he
closes the System Configuration dialog.
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Methods in the
.NET assembly

The
AddressTranslati
onlnit () method

60

The .NET assembly could not be found or is incorrect.
Physical Addresses will not be displayed

bool AddressTranslationInit (CString strToolName, _ intlé & nNumberOfBit
s)

Each DDR decoder on the LA workspace will call this method when it is
initialized with a configuration file, or when the "OK" button is pressed in
the "System Configuration" dialog.

Note: This means that the method may be called multiple times with the
same ToolName. The method must tolerate this without an error return.

The .dll will use this method as an opportunity to display a GUI for the
user to set assorted configuration parameters that will be used in the
PhysicalAddress method such as number of row bits, number of column
bits and number of bank address bits etc.

strToolName = Unicode string, The name of the DDR Bus decode tool.
Since it is possible for the user to have multiple memory systems, each
with it's own DDR bus decode tool, it is necessary to tell the
AddressTranslationInit () method and the PhysicalAddress() method which
instance of the DDR bus decoder is making the request; e.g. In the
following example there are two instances of the bus decoder. One is
called 'DDR Bus Decoder-1' and one is called 'DDR Bus Decoder-2'. Note: it
is the responsibility of the .dll to maintain a data structure of each call to
AddressTranslationlnit (); i.e. for each strToolName.

nNumberOfBits = Return value: number of bits of physical address to be
displayed by the decoder.

If the call to the method throws an exception (method does not exist,
parameter list is wrong etc.) the decoder will display the following error
message and will display all subsequent physical address as <blank>.

Unable to invoke member AddressTranslationInit ().
Physical Addresses will not be displayed

If the call to the method succeeds but the method returns false, the
decoder will display the following error message and will display all
subsequent physical address as <blank>.

DDRtoPhysical: :AddressTranslationInit () returned false.
Physical Addresses will not be displayed

The decoder proceeds with decode, displaying all Physical Addresses as
<blank>. In this case, the decoder will never call the PhysicalAddress()
method. Note: we display <blank> rather than "unknown" because the
Physical Address label is a numeric label, not a string label.
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The ©bool PhysicalAddress ( CString strToolName,

PhysicalAddress( __intlé RankaAdd,
) method __intlé BankAddr,

__intlé RowAddr,
___intleé ColAddr,
__int64 & PhysicalAddress)

If the user has selected "User supplied .NET assembly", the DDR tool will
call this method each time it needs to compute a physical address.

strToolName = The tool name as described above in the Init() method. The
PhysicalAddress() method may choose to ignore this parameter, or it may
use it to apply a unique algorithm based on the tool name and its
associated AddressTranslationlnit ().

RankAddr = Rank address

BankAddr

Bank address bits

RowAddr = Address bus for applicable activate command
ColAddr = Address bus for applicable R/W command
PhysicalAddress = return value

If the call to the method throws an exception (method does not exist,
parameter list is wrong etc.) the decoder will display the following error
message and will display all subsequent physical address as <blank>.

Unable to Invoke member PhysicalAddress() .
Physical Addresses will not be displayed

If the call to the method succeeds but the method returns false, the
decoder will display the following error message and will display all
subsequent physical address as <blank>.

DDRtoPhysical: :PhysicalAddress () returned false.
Physical Addresses will not be displayed

The bool BusAddress ( CString strToolName,

BusAddress() __intle &RankAdd,
method __intl16 &BankAddr,

__intleé &RowAddr,
__intleé &ColAddr,
__int64 PhysicalAddress)

This is an optional method. If it exists and if the user has selected "User
supplied .NET assembly", the method will be used by the Address
Conversion tool to convert physical addresses to bus addresses.

strToolName = The tool name as described above in the Init() method. The
BusAddress() method may choose to ignore this parameter, or it may use
it to apply a unique algorithm based on the tool name and its associated
AddressTranslationlnit ().

RankAddr = Return Value
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The

NameChanged()

62

method

Sample
DDRtoPhysical
class

BankAddr = Return Value
RowAddr = Return Value
ColAddr = Return Value

PhysicalAddress = Physical address to be converted to Rank, Bank, Row,
Column

If the call to the method throws an exception (method does not exist,
parameter list is wrong etc.) the decoder will display the following error
message and all controls in the Address Conversion dialog will be disabled.

Unable to Invoke member BusAddress() .
Address Conversion dialog disabled

If the call to the method succeeds but the method returns false, the
decoder will display the following error message.

DDRtoPhysical: :BusAddress () returned false.
Address Conversion dialog disabled

bool NameChanged ( CString strOldToolName, CString strNewToolName)

This method will be called whenever the user changes the name of the bus
decoder in the overview. The method is also called when loading a config
file. In this case, the OldToolName and the NewToolName are identical.

If the call to the method throws an exception (method does not exist,
parameter list is wrong etc.) the decoder will display the following error
message and will display all subsequent physical address as <blank>.

Unable to Invoke member NameChanged () .
Physical Addresses will not be displayed

If the call to the method succeeds but the method returns false, the
decoder will display the following error message and will display all
subsequent physical address as <blank>.

DDRtoPhysical: :NameChanged () returned false.
Physical Addresses will not be displayed

Public Class DDRtoPhysical

Public Function AddressTranslationInit (ByVal strToolNameAsString,
ByRef nNumberOfBitsAsIntlé) AsBoolean

MsgBox ("In AddressTranslationInit. ToolName = " & strToolName)
nNumberOfBits = 48
Return True

End Function

Public Function PhysicalAddress (ByVal strToolNameAsString, _
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ByVal nRankAddrAsIntlé, ByVal nBankAddrAsIntlé,
ByVal nRowAddrAsIntlé, ByVal nColAddrAsIntleé,
ByRef nAddressAsInt64) AsBoolean

nAddress = nRankAddr + nBankAddr + nRowAddr + nColAddr
Return True
End Function
Public Function BusAddress (ByVal strToolNameAsString,
ByRef nRankAddrAsIntlé, ByRef nBankAddrAsIntlé,
ByRef nRowAddrAsIntlé, ByRef nColAddrAsIntle,

ByVal nAddressAsInt64) AsBoolean

nRankAddr nAddress + 1

nBankAddr = nAddress + 2

nRowAddr = nAddress + 3

nColAddr = nAddress + 4
Return True
End Function
Public Function NameChanged (ByVal strToolOldNameAsString,
ByVal strToolNewNameAsString) AsBoolean

MsgBox ("In NameChanged: Old name = " & strToolOldName &
" New name = " & strToolNewName)

Return True

End Function

End Class
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